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 Giriş 
 

 Free Cooling Viewer yazılımı" Free Cooling v4" kontrol ünitelerinin Usb, RS232 ve Ethernet 

bağlantı noktalarından birini kullanarak yönetimini bir Ara yüz ile PC üzerinden basitçe yapabilmesi 

amaçlanarak geliştirilmiş 3.parti bir Windows uygulamasıdır. 

 Free Cooling Viewer yazılımının mevcut yetenekleri; 

  FCS v4 kontrol ünitesini, 

 Gerçek zamanlı izleme ve grafik olarak görüntüleme 

 Çalışma parametrelerini görüntüleme 

 Çalışma parametrelerini değiştirme 

 Çalışma parametrelerini varsayılan olarak geri yükleme 

 Tuş takımını kullanıma kapatma/açma 

 Yeniden başlatma 

 Mevcut hafızadaki dataları silme 

 Hafızadaki datalarının indirme ve MS Excel formatında raporlama 
  

.
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 Yazılımın Kullanımı 
 

1. Menü çubuğu 
 

 

 

 Yazılımın en üstünde yer alan menü kullanılarak cihaz ayarları kontrol edilebilir ve 

yönetilebilir. Menü yardımıyla sırasıyla aşağıdaki işlevler gerçeklenebilir. 

a) Real Time Monitor  

  

 Real time Monitor menüsünden; 

 Text Monitor seçeneği kullanılarak, bir listeye alt alta eklenen metin datalarını 

görüntüleyebileceğiniz pencereye geçiş yapabilir.  
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 Graph Monitor seçeneği kullanılarak,  tüm dataları bir grafik üzerinde gerçek zamanlı olarak 

takip edebileceğiniz pencereye geçiş yapılabilir. 

 

b) View 

  

 View menüsünden; 

 Show All External Plug and Play Cards  

  -> Alarm Card seçeneği kullanılarak, Sistemdeki alarm kartının mevcut durumu ile 

ilgili bilgi görüntülenir 
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 ->  Input Control Card: Sistemdeki giriş kartının mevcut durumu ile ilgili bilgi görüntülenir. 

 

 Giriş kartında ilk giriş yangın alarmı için tanımlanmıştır. Diğer girişler kullanıcı tanımlı 

olarak değiştirilebilir.  

File - > Import contacts name table seçeneği kullanılarak, kullanıcı tanımlı tüm girişlerin 

isimleri daha önceden kayıtlı olan bir dosyadan yüklenebilir. 

File -> Export contacts name table seçeneği kullanılarak, kullanıcı tanımlı tüm girişlerin 

isimleri harici depolama aygıtlarına, PC vb. kayıt ortamlarına aktarılabilir. 

Edit - > Replace name seçeneği kullanılarak, tüm girişler kullanıcı tanımlı olarak yeniden 

adlandırılabilir. Yapılan değişiklik Save butonu ile onaylanır. 
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  ->  Output Control Card: Sistemdeki çıkış kontrol kartının mevcut durumu ile ilgili 

bilgi görüntülenir. Çıkışların durumları değiştirilebilir. 

 

File - > Import contacts name table seçeneği kullanılarak, kullanıcı tanımlı tüm çıkışların 

isimleri daha önceden kayıtlı olan bir dosyadan yüklenebilir. 

File -> Export contacts name table seçeneği kullanılarak, kullanıcı tanımlı tüm çıkışların 

isimleri harici depolama aygıtlarına, PC vb. kayıt ortamlarına aktarılabilir. 

Edit - > Replace name seçeneği kullanılarak, tüm çıkışlar kullanıcı tanımlı olarak yeniden 

adlandırılabilir. Yapılan değişiklik Save butonu ile onaylanır. 
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 Show / Hide Opr. Mode Alarms Status of Peripherals seçeneği kullanılarak, Sağ panelde 

gizlenir, görünür durumları değiştirilir. 

 Sağ panelde, bağlı durumda bulunulan FCS v4 cihazının çalışma modu, meydana gelen 

alarmların tümü ve çalışma esnasında kontrol edilen aktif ve pasif durumdaki çevre birim 

elemanlarının durumları izlenebilir. 

  

Aktif çalışma 

modu bilgisini 

verir. 

Sistemde meydana gelen 

alarmların bilgilerini verir. Bu 

kısımda yanlızca oluşan alarmlar 

hakkında bilgi verilir. Uzak 

noktaya taşınan alarmlar 

hakkında bilgi vermez. 

Aktif veya pasif 

durumda olan çevre 

birim elemanlarının 

bilgisini verir. 

Sensor, DC besleme ve Şebeke 

hatalarının sayının bilgisi 

verilir. 
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 Show / Hide Gauge Panel seçeneği kullanılarak, gösterge panelde gizlenir, görünür durumları 

değiştirilir. 

 Gauge panelde, bağlı durumda bulunan FCS v4 cihazının ölçüm değerleri neticesinde 

meydana gelen tüm sayısal datalar gösterge panelinde izlenebilmektedir. 

 

 Show Power Analyzer Screen seçeneği kullanılarak, sayaç verileri, görüntülenebilir. 
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c) Logs / Graphs 

  

 Logs/Graphs menüsünden; 

 Download Event Log Export MS Excel seçeneği kullanılarak, bağlı bulunulan FCS v4 

sisteminin hafızasında kayıtlı bulunan olay, durum ve alarm dataları çekilerek MS Excel olarak 

raporlanır. 

 Download Total Operation Time of Fan and Air Conditioner Export MS Excel seçeneği 

kullanılarak, bağlı bulunulan FCS v4 sisteminin hafızasında kayıtlı bulunan günlük fan ve klima çalışma 

süreleri, günlük fan ve klima tüketim miktarlarına ait datalar çekilerek MS Excel olarak raporlanır. 

 Cihazdan datalar indirilmesi ve raporlanması 2 aşamalı olarak görüntülenmektedir.  

 

1.aşama hazıfadaki dataların çekilmesi  

( Transfering data (1/2) )  

 

 

 

 

 

 

 

2.aşama, 1.aşamada çekilen dataların MS 

Excel raporlanması 

 ( Progressing data (2/2) ) 
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d) Device Parameters 

  

 Device Parameters menüsünden; 

 New Parameters seçeneği kullanılarak,  bağlı bulunulan FCS v4 sistemine ait mevcut çalışma 

ayarları yeni ayarlarla değiştirilir. Aşağıdaki pencerede yapılan çalışma ayarlarıyla ilgili değişiklikleri 

FCS v4 sistemine göndermek için Send All Parameters to FCS butonu kullanılır. 
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View Parameters seçeneği kullanılarak, bağlı bulunulan FCS v4 sisteminin çalışma ayarları 

görüntülenir. Çeşitli diğer parametreleri görüntüleyebilmek için sol taraftan yer alan simgeleri 

kullanınız. 

 

 

 Restore Default Parameters seçeneği kullanılarak, bağlı bulunulan FCS v4 sistemi çalışma 

ayarları fabrika ayarlarına geri döndürülür.  
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 FCS sisteminin çalışmasını belirleyecek sınır değerler ayarlanır. Bu menüde aşağıdaki 

ayarlamalar yapılır. 

 Parametre Durum Birim Varsayılan Min Max 

1 A/C delay protection  Sn 300 0 300 

2 A/C minimum operating voltage  V 120 100 200 

3 A/C maximum operating voltage  V 245 220 270 

4 
Forced A/C mode operation ON / OFF - OFF   

Forced A/C mode operation  Min. 15 0 180 

5 A/C minimum work time in 8 minutes ON / OFF - OFF - - 

6 Turn off if A/C if it operates poor ON / OFF - OFF - - 

7 
Turn on A/C if high outdoor temperature ON / OFF  ON   

Turn on A/C if high outdoor temperature  °C 25 18 36 

8 A/C turn on temperature  °C 28 22 38 

9 A/C turn off temperature  °C 24 20 36 

10 Run A/Cs , if No AC Phase ON / OFF - OFF   

11 *A/C1 - A/C2 Delta temerature  °C 5 1 10 

12 
*Switch the A/C using timing ON / OFF  OFF   

*Switch the A/C using timing  min 120 120 240 

13 Fan turn on temperature  °C 22 15 25 

14 Fan turn off temperature  °C 28 22 38 

15 Selection of Fan type DC / AC - DC - - 

16 

Fan power type 55w,120w,190w,380w Watt 55w - - 

Fan speed (Night)  % 50 15 100 

Fan speed (Daytime)  % 100 15 100 

17 Indoor-outdoor delta temperature  °C 2 2 5 

18 
Critical indoor temp max fan speed, no AC ON / OFF  ON   

Critical indoor temp max fan speed, no AC   30 28 38 

19 A/C phase fail fan speed HALF-MAX  HALF   

20 Fan with work the A/C mode ON / OFF  OFF   

21 Show Fan Speed Value Type On LCD %RPM / Decimal RPM  % RPM   

22 Humidity Algorithm ON / OFF - OFF   

23 A/C Phase Fail fan Off ON / OFF - OFF   

24 Mixed Mode Start Temperature  °C 35 32 45 

25 
Mixed mode fan turn off temp Set - Diff  Set   

Mixed mode fan turn off temp  °C 32 22 42 

26 Mixed mode A/C turn off temp  °C 25 20 36 

27 Heating method A/C - Heater - A/C   

28 Heater turn on temperature  °C 10 2 10 

29 Heater turn off temperature  °C 16 14 18 

30 *Heater 1 and 2 Delta temerature  °C 5 1 10 

31 
Fan off, outdoor temp. high ON / OFF - OFF   

Fan off, outdoor temp. high  °C 45 40 60 

32 
Fan off, outdoor temp. low ON / OFF - OFF   

Fan off, outdoor temp. low  °C 10 -20 10 
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33 
Fan off, Maximum indoor humidity ON / OFF - ON   

Fan off, Maximum indoor humidity  °C 85 50 95 

34 Fan Paramater enable in mixmode ON / OFF - OFF   

35 

FCS Working Mode Daytime / Night - Night   

Start of the night  - 20:00   

Stop of the night  - 08:00   

36 A/C 1 Type Standart / Inverter - Standart   

37 A/C 2 Type  Standart / Inverter - Standart   

38 Low batt alarm threshold  V -44 (+22) -42 (*21) -46(*23) 

39 High batt alarm threshold  V -54 (+27) -54 (*27) -60(*30) 

40 Low temp alarm threshold  °C 8 4 12 

41 High temp alarm threshold  °C 35 25 35 

42 Very High temp alarm threshold  °C 40 35 45 

43 Mobile Station Mode ON / OFF - OFF   

44 Low voltage alarm ON / OFF - OFF   

45 High voltage alarm ON / OFF - OFF   

46 Low temp alarm ON / OFF - ON   

47 High temp alarm ON / OFF - ON   

48 Very High temp alarm ON / OFF - ON   

49 
Filter pressure alarm ON / OFF - OFF   

Threshold  Pa 500 200 500 

50 A/C1 phase power alarm ON / OFF - OFF   

51 A/C2 phase power alarm ON /OFF - OFF   

52 Poor heating alarm ON / OFF - OFF   

53 Poor cooling alarm ON / OFF - OFF   

54 Fan power alarm ON / OFF - OFF   

55 Fan speed (RPM) alarm ON / OFF - OFF   

56 Max humidity alarm ON / OFF - ON   

57 Dew-point alarm ON / OFF - OFF   

58 Show FCS alarms on LCD ON / OFF - ON   

59 Date / Time Date &Time - -   

60 Automatic Summer-Winter Time Adjustment Check / Uncheck - Checked   

61 
Send the NMS data in case of the events 
and alarms 

ON / OFF - OFF   

62 The period of the sending NMS data ON / OFF - 1440 5 1440 

63 DG Control ACTIVE / PASSIVE - PASSIVE   

64 DG Working Time  Min 240 5 255 

65 DG Start Low Battery (DC) Threshold  V -44 (+22) 

-42 (*21) 

-46(*23) 

 

-42 (*21) -46(*23) 

66 DG Start Low Temperarute Threshold  °C 8 4 12 

67 DG Start High Temperature Threshold  °C 40 35 45 

 

* Çift fazlı sistemlerde kullanılan set değerleridir.. 
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“A/C Delay Protection” 

 Klima Koruma Gecikmesi  

 Elektrik kesintilerinin sık olması durumunda bu ayar ile klima çalıştırıldığında kompresör set 
edilen süre kadar devre dışı bırakılır ve böylece klima korunur.  

“A/C Minimum Operating Voltage” 

 Klima Minimum Çalışma Gerilimi 

 Sistemde kullanılan klimanın özelliklerine bakılarak minimum çalışma gerilimi ayarlanır. Bu 
ayar ile şebeke gerilimi düştüğünde klimanın zarar görmesi engellenir.  

“A/C Maximum Operating Voltage” 

 Klima Maksimum Çalışma Gerilimi 

 Sistemde kullanılan klimanın özelliklerine bakılarak maksimum çalışma gerilimi ayarlanır. Bu 
ayar ile şebeke gerilimi yükseldiğinde klimanın zarar görmesi engellenir.  

“Forced A/C Mode Operation” 

 Zorunlu Klima Modunda Çalışma 

 Bu ayar ile klima devreye alındıktan sonra koşulsuz devrede kalma süresi belirlenir.  

“A/C Minimum Work Time in 8 Minutes” 

 Minimum Klima Çalışma Süresi 8 Dakika 

 Bu ayar ON konumuna getirildiğinde klima bir kez devreye girdiği anda en az 8 dakika 
çalıştırılır.  

“Turn Off A/C if it Operates Poor” 

 Klima Yetersiz ise kapat 

 Bu ayar ON konumuna getirildiğinde, klima modunda çalışmada, soğutma performansı 
yetersiz ise klima, fazla enerji harcamaması için kapatılır.  

“Turn On A/C if High Outdoor Temperature” 

 Yüksek Dış Sıcaklıkta Klima Çalıştır. 

  Bu ayar ON konumuna getirildiğinde, Dış sıcaklık belirlenen değeri geçtiğinde F/C 
modu devre dışı bırakılarak, çalışma klima modunda devam ettirilir.  
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“A/C Turn On Temperature”  

 Klima Devreye Girme Sıcaklığı  

 (F/C) Serbest soğutmanın yetersiz kaldığı durumlarda klimanın devreye gireceği iç ortam 
sıcaklığı belirlenir. Klimanın devreye alınması için şebekenin algılanması ile birlikte set edilen 
minimum çalışma geriliminin de şebeke tarafından sağlanması gerekmektedir. Aksi durumda, 
klimanın devreye girme şartları oluşsa dahi klima çalıştırılmaz. 

“A/C Turn Off Temperature” 

 Klima Durma Sıcaklığı  

 Klimanın duracağı iç ortam sıcaklığı ayarlanır.  

“Run A/Cs, if No AC Phase” 

 Şebeke (220V AC) Kesintilerinde Klimalara Çalıştır.  

 Sisteme bağlı klima fazlarında meydana gelen kesintilerde bu parametre “On” olarak set 
edilirse, faz kesintisinin olduğu faz’a bağlı klima çalıştırılır.  

* “A/C1 - A/C2 delta temperature” (2 fazlı sistemlerde)  

 2.Klima Devreye Girme Sıcaklığı 

 2 Klimalı sistemlerde 1.klimanın yetersiz kaldığı anlarda 2.klimanın devreye girme sıcaklığı bu 
ayarda set edilir. 

* “Switch the A/C using timing” (2 fazlı sistemlerde) 

 2.Klima Sistemde Klimaları Zamanlı Çalıştırma 

2 Klimalı sistemlerde, klimalardan her birinin çalışma süresi set edilen değeri geçtiği 
durumlarda sistem soğutma işlemini aktif klimadan pasif klimaya otomatik olarak anahtarlar. Böylece 
yaz aylarında uzun saatler klimaya ihtiyaç duyulan anlarda klimaların dengeli ve eşit yüklerde 
çalışması sağlanabilmektedir  

“Fan Turn On Temperature” 

 Fanın Çalışma Sıcaklığı  

 Fanın çalışmaya başlayacağı iç ortam sıcaklığı ayarlanır. Fan sigortası(F1) takılı değilse veya 
nem set edilen değerden fazla ise veya DC besleme gerilimi fan için uygun değilse veya dewpoint var 
ise, fan çalışma koşulu oluşsa dahi fan çalışmaz.  

“Fan Turn Off Temperature” 

 Fan durma sıcaklığı  

 Fanın devre dışı bırakılacağı iç ortam sıcaklığı ayarlanır.  
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“Selection of Fan Type” 

 Fan Seçimi  

 Kurulumda DC fan seçilmiştir. Fan seçimi DC veya AC olarak yapılabilir.  

“Fan Power Type &  Day-Night Speed” 

 Fan gücü ve gündüz-gece hızları ayarlama 

 Sistemde kullanılan fanın gücü ve bu fanın gündüz ve gece modlarında ne oranda kullanılmak 
istendiği bu ekrandaki parametreleri ayarlayarak gerçekleştirilir.  

“Indoor - Outdoor Delta Temperature” 

 İç - Dış Sıcaklık Farkı  

 Fanın maksimum hıza ulaşacağı iç-dış sıcaklık farkı belirlenir. İç-dış sıcaklık farkı soğutma 
kapasitesi üzerinde etkilidir. Ölçülen iç-dış sıcaklık farkı, ayarlanan iç dış farkına eşit veya büyük ise 
fan en yüksek hızda çalıştırılacaktır.  

“Critical Indoor Temp Max Fan Speed, No AC” 

 Kritik İç Sıcaklık Maksimum Fan Hızı 

 İç-dış sıcaklık farkından bağımsız olarak, kritik iç sıcaklık değerinde fanın maksimum hızda 
çalıştırılması bu ayar “ON” yapılarak sağlanır.  

Enerji kesikken fanın sürekli maksimum hızda çalışmasının belirlendiği iç sıcaklık ayarlanır.  

“A/C Phase Fail Fan Speed” 

 Elektrik Yok Fan Hızı 

 Şebeke enerjisinin kesik olduğu durumlarda fanın ulaşabileceği en yüksek hız “HALF” 
seçilerek yarı, “MAX” seçilerek tam hıza ayarlanır 

“Fan Work With The A/C Systems” 

 Klima modunda Fan çalıştırma 

 Bu ayar ile klima devreye alındıktan sonra iç-dış sıcaklık farkı fana gerek duyulacak oranda 
olduğu her durumda fan da çalıştırılır.  

“Show Fan Speed Value Type On LCD” 

 LCD Ekranda Fan Hızı Değerini Göster 

 Bu ayar ile fan devrinin lcd ekranda görünümünün Decimal yada Yüzdesel olarak farklı 
biçimlerde görünümü set edilebilir. 

  



18 
 

“Humidity Algorithm” 

 Nem Algoritması 

 Bu ayar “ON” olarak set edildiğinde Fan Çalışma biçimi sıcaklık farkı kontrolünün yanına nem 
kontrolünü de ekleyerek karmaşık bir algoritma çalıştırılır. Bu algoritma ile nem seviyesi sınır değer 
seviyelerinde gezebilir.  

“A/C Phase Fail Fan OFF” 

 Klima Fazları Kesildiğinde Fan Kapat 

 Bu ayar “ON” olarak set edildiğinde sistemde yapılan ölçümlerde algılanan bir şebeke noktası 
olmadığında fan çalıştırılmaz. 

“Mixed Mode Start Temperature” 

 Mixed Mode Başlama Sıcaklığı 

Mixed mode durumunun başlatılacağı iç ortam sıcaklık değeri ayarlanır.  

“Mixed Mode Fan Turn Off Temp” 

 Mixed mode Fan Durma Sıcaklığı 

 “Set” seçildiğinde mixed mode şartı gerçekleşirse fan “Mixed Mode Fan Turn Off Temp” ile 
ayarlanan sıcaklık değerine ulaştığında durur. Diff seçildiğinde ise mixed mode şartı gerçekleştiğinde 
fan “Mixed Mode Fan Turn Off Temp” ile ayarlanan değerin 3 °C altına inilirse durur. Mixed mode 
çalışma şartı gerçekleştiğinde fanın duracağı iç sıcaklık belirlenir.  

“Mixed Mode A/C Turn Off Temp” 

 Mixed Mode Klima Durma Sıcaklığı 

 Mixed Mode; iç sıcaklık “Mixed Mode Start Temperature” (Mixed Mode Başlama Sıcaklığı) 
değerinin üzerine çıkarsa fan ve klima birlikte çalışarak iç ortam sıcaklığını düşürmeye çalışırlar. 

“Heating Method” 

 Isıtma Methodu 

 Bu ayar ile ısıtma moduna ihtiyaç duyulan durumlarda ıstıma elemanı olarak kullanılan 
eleman belirtilir.  

“ Bu ayar ile eğer ısıtıcı olarak klima kullanırsanız ısıtıcı kontağını dizel jeneratör çıkışı olarak 
kullanabilirsiniz. 

“Heater Turn ON Temperature” 

 Isıtıcı Çalışma Sıcaklığı  

 Isıtıcının (klima ısıtma modunda da çalıştırılabilir) devreye girme sıcaklığı belirlenir.  
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“Heater Turn Off Temperature” 

 Isıtıcı Durma Sıcaklığı  

 Isıtıcının (klima ısıtma modunda da çalıştırılabilir) devreden çıkartılacağı sıcaklık belirlenir.  

* “Heater 1 - 2 delta temperature” (2 fazlı sistemlerde) 

 2.Isıtıcı (klima) Devreye Girme Sıcaklığı 

 2 fazlı sistemlerde 1. ısıtıcı (klima) yetersiz kaldığı anlarda 2.ısıtıcı (klima)' ın devreye girme 
sıcaklığı bu ayarda set edilir. 

“Fan Off, Outdoor Temperature High” 

 Dış sıcaklık çok yüksek fan kapat 

 Cihazın ölçümleri sonucunda dış sıcaklık set edilen değere yükseldiğinde fan çalışması 
durdurulur, dışarıdan alınan hava akışı durdurulur. Dış sıcaklık yüksek fanı kapat set değeri bu 
ekranda ayarlanır 

“Fan Off, Outdoor Temperature Low” 

 Dış sıcaklık çok düşük fan kapat 

 Cihazın ölçümleri sonucunda dış sıcaklık set edilen değere düştüğünde fan çalışması 
durdurulur, dışarıdan alınan hava akışı durdurulur. Dış sıcaklık düşük fanı kapat set değeri bu ekranda 
ayarlanır.  

“Fan Off, Maximum Indoor Humidity” 

 İç nem çok yüksek fan kapat 

 Cihazın ölçümleri sonucunda iç nem set edilen değere yükseldiğinde fan çalışması durdurulur, 
dışarıdan alınan hava akışı durdurulur. Bu ayar ile iç ortam nem değeri, cihazların sağlıklı 
çalışabileceği aralıkta tutulur. İç nem yüksek fanı kapat set değeri bu ekranda ayarlanır.  

“Fan Parameter Enable in Mixmode” 

 Dış sıcaklık yüksek, düşük ve iç nem yüksek fanı kapat parametreleri Mix Mode 
etkinleştir. 

 Cihazın ölçümleri sonucunda dış sıcaklığın düşük, yüksek ve iç nemin yüksek olduğu 
durumlarda mix mode durumunda bu parametre ile fan çalışması durdurulur, dışarıdan alınan hava 
akışı durdurulur.  
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“FCS Working Mode” 

 FCS Çalışma Modu  

 Free Cooling sistemin Gündüz ve Gece çalışma seçeneği burada belirlenir.  

“Start of Night” - “Stop of the Night” 

 Gece Modu Başlangıcı - Gece Modu Bitişi 

 Fan gürültüsünün azaltılmak istendiği yerlerde gece modu kullanılabilir. Gece modu başlangıç 
ve bitiş saatleri 20.00 ile 08.00 arasında ayarlanabilir.  

“Low Batt Alarm Threshold” 

 Düşük Çalışma Gerilimi Eşiği Alarmı 

 Varsayılan olarak düşük çalışma gerilimi eşiği alarmı “-48 VDC” ile çalışmada “-44 VDC”, “24 
VDC” ile çalışmada ise “22 VDC” olarak ayarlanmıştır. Cihazın besleme gerilimi bu sınırların altına 
indiğinde düşük çalışma gerilimi eşiği alarmı üretilmektedir. Bu alarm oluştuğu takdirde, DC fan 
çalışma koşulu oluşsa dahi devreye alınmaz. 

“High Batt Alarm Threshold” 

 Yüksek Çalışma Gerilimi Eşiği Alarmı 

 Varsayılan olarak düşük çalışma gerilimi eşiği alarmı “-48 VDC” ile çalışmada “-54 VDC”, “24 
VDC” ile çalışmada ise “27 VDC” olarak ayarlanmıştır. Cihazın besleme gerilimi belirlenen değerlerin 
üzerine çıktığında yüksek çalışma gerilimi eşiği alarmı üretilmektedir. Bu alarm oluştuğu takdirde, DC 
fan çalışma koşulu oluşsa dahi devreye alınmaz.  

“Low Temp Alarm Threshold” 

 Düşük Sıcaklık Alarmı 

 Alarm verilecek en düşük iç ortam sıcaklığını belirlenir. 

“High Temp Alarm Threshold” 

 Yüksek Sıcaklık Alarmı 

 İç ortam sıcaklığının yükselmesi durumunda yüksek sıcaklık alarmının başlayacağı sıcaklık 
değeri belirlenir.  

“Very High Temp Alarm Threshold” 

 Çok Yüksek Sıcaklık Alarmı 

 İç ortam sıcaklığının çok yükselmesi durumunda çok yüksek sıcaklık alarmının başlayacağı 
sıcaklık değeri belirlenir.  
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“Mobile Station Mode” 

 Mobil İstasyon Moduı 

 Bu ayar “ON” olarak set edilirse, FREE COOLING çalışma modu mobil istasyonlara uygun bir 
algoritma ile çalışmasına devam eder.  

“Low Voltage Alarm” 

 Düşük Besleme Gerilimi Alarmı  

 Cihaza uygulanan gerilim normal besleme geriliminden düşük ise “Düşük Besleme Gerilimi 
Alarmı” üretilir. Düşük gerilim alarmının kuru kontak çıkışı olarak verilmesi, ekranda gösterilmesi ve 
harici alarm kartından verilmesi ayarlanır. 

“High Voltage Alarm” 

 Yüksek Besleme Gerilimi Alarmı 

 Cihaza uygulanan gerilim normal besleme geriliminden yüksek ise “Yüksek Besleme Gerilimi 
Alarmı” üretilir. Yüksek gerilim alarmının kuru kontak çıkışı olarak verilmesi, ekranda gösterilmesi ve 
harici alarm kartından verilmesi ayarlanır. 

“Low Temp Alarm” 

 Düşük Sıcaklık Alarmı 

 İç sıcaklık set edilen minimum değerin altında ise düşük sıcaklık alarmın kuru kontak çıkışı 
olarak verilmesi, ekranda gösterilmesi ve harici alarm kartından verilmesi ayarlanır. 

“High Temp Alarm” 

 Yüksek Sıcaklık Alarmı 

 Yüksek sıcaklık alarmı oluştuğunda bu alarmın kuru kontak çıkışı olarak verilmesi, ekranda 
gösterilmesi ve harici alarm kartından verilmesi ayarlanır. 

“Very High Temp Alarm” 

 Çok Yüksek Sıcaklık Alarmı 

 Çok yüksek sıcaklık alarmı oluştuğunda bu alarmın kuru kontak çıkışı olarak verilmesi, 
ekranda gösterilmesi ve harici alarm kartından verilmesi ayarlanır.  

“Filter Pressure Alarm” 

 Filtre Basınç Alarmı 

 Hava giriş filtresi yeterli hava akışını sağlayamayacak kadar kirlendiğinde, oluşan alarmın kuru 
kontak çıkışı olarak verilmesi, ekranda gösterilmesi ve harici alarm kartından verilmesi ayarlanır. 
Filtre basınç alarmı ON yapılarak onaylandıktan sonra ekranda alarmın hangi basınç değerinde 
verileceğinin ayarlandığı ekran gelir. 



22 
 

“A/C1 Phase Power Alarm” 

 Enerji Kesik Alarmı 1 

 Şebeke enerjisi kesildiğinde oluşan alarmın kuru kontak çıkışı olarak verilmesi, ekranda 
gösterilmesi ve harici alarm kartından verilmesi ayarlanır.  

“A/C2 Phase Power Alarm” 

 Enerji Kesik Alarmı 2 

 Şebeke enerjisi kesildiğinde oluşan alarmın kuru kontak çıkışı olarak verilmesi, ekranda 
gösterilmesi ve harici alarm kartından verilmesi ayarlanır.  

“Poor Heating Alarm” 

 Yetersiz Isıtma Alarmı 

 Isıtma yapılırken bir saatlik süre içerisinde iç ortam sıcaklığı istenen değere (ısıtıcı OFF 
sıcaklığı)  getirilemiyorsa ısıtma yetersiz alarmı oluşur. Bu durumda alarmın kuru kontak çıkışı olarak 
verilmesi, ekranda gösterilmesi ve harici alarm kartından verilmesi ayarlanır. 

“Poor Cooling Alarm” 

 Soğutma Zayıf Alarmı 

 Soğutma yapılırken iç ortam sıcaklığı bir saat içerisinde ayarlanan değere getirilemiyorsa zayıf 
soğutma alarmı oluşur. Bu durumda alarmın kuru kontak çıkışı olarak verilmesi, ekranda gösterilmesi 
ve harici alarm kartından verilmesi ayarlanır. 

“Fan Power Alarm” 

 Fan Beslemesi Yok Alarmı 

 Fan beslemesi yoksa (F1 10AT sigortanın bozulması vb) alarm oluşur. Alarmın kuru kontak 
çıkışı olarak verilmesi, ekranda gösterilmesi ve harici alarm kartından verilmesi ayarlanır.  

“Fan Speed (RPM) Alarm” 

 Fan Hızı Alarmı  

 Fan hızında bir problem olduğunda alarm verilir. Alarmın kuru kontak çıkışı olarak verilmesi, 
ekranda gösterilmesi ve harici alarm kartından verilmesi ayarlanır.  

“Max Humidity Alarm” 

 Yüksek Nem Alarmı 

 İç ortamdaki nem, ayarlanan en yüksek nem değerini aşarsa, yüksek nem alarmının kuru 
kontak çıkışı olarak verilmesi, ekranda gösterilmesi ve harici alarm kartından verilmesi ayarlanır.  
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“Dew-Point Alarm” 

 Çiy Var Alarmı 

 Çiy oluşursa, alarmın kuru kontak çıkışı olarak verilmesi, ekranda gösterilmesi ve harici alarm 
kartından verilmesi ayarlanır.  

“Date / Time” 

 Tarih Saat Ayarı 

 Sistem tarih ve saati buradan set edilir.  

“Automatic Summer – Winter Time Adjustment” 

 Otomatik Yaz – Kış Ayarı 

 Bu parametre işaretlenirse sistem otomatik yaz – kış geçişlerini kendisi yapar.  

“Send the NMS data in case of the events and alarms” 

 Olayları ve Alarmları Yönetim Sistemine Gönder 

 Bu ayar ON yapılırsa, meydana gelen olaylar ve alarmlar yönetim sistemine iletilir.  

“The period of the sending NMS data” 

 NMS data gönderme sıklığı 

 Bu ayar ON yapılırsa, meydana gelen olaylar ve alarmlar yönetim sistemine belirlenen zaman 
aralıklarında gönderilir.  

“DG Control” 

 Jeneratör Kontrol 

 Bu ayar ON yapılırsa ısıtıcı kontaktorü dizel jeneratör start ve stop kuru kontak kontrol için 
kullanılır hale getirilir. 

*Bu özelliğin kullanılabilmesi için ısıtıcı olarak ayarlardan klima kullanılır biçimde set edilmesi 
gerekmektedir. .  

“DG Working Time” 

 Jeneratör Çalıştırma Süresi 

 Bu ayar ile jeneratör start şartlarından bir yada bir çoğu gerçekleştikten sonra ne kadar süre 
jeneratör çalıştırılacağı set edilir.  
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“DG Start Low Battery (DC) Threshold” 

 Jeneartor Çalıştırma Düşük Gerilim Eşiği 

 Varsayılan olarak düşük gerilimi eşiği “-48 VDC” ile çalışmada “-44 VDC”, “24 VDC” ile 
çalışmada ise “22 VDC” olarak ayarlanmıştır. Cihazın besleme gerilimi bu sınırların altına indiğinde 
düşük çalışma gerilimi eşiği alarmı üretilmektedir. Bu alarm oluştuğu takdirde, jeneratör kontrol 
özelliğine bağımlı olarak jeneratör devreye alınır 

“DG Start Low TemperatureThreshold” 

 Jeneratör Çalıştırma Düşük Sıcaklık Seviyesi 

 İç ortam sıcaklığı set edilen seviyenin altına düştüğünde düşük sıcaklık alarmı üretilmektedir. 
Bu alarm oluştuğu takdirde jeneratör kontrol özelliğine bağımlı olarak jeneratör devreye alınır. 

“DG Start High Temperature Threshold” 

 Jeneratör Çalıştırma Yüksek Sıcaklık Seviyesi 

 İç ortam sıcaklığı set edilen seviyenin üstüne çıktığı anda çok yüksek sıcaklık alarmı 
üretilmektedir. Bu alarm oluştuğu takdirde jeneratör kontrol özelliğine bağımlı olarak jeneratör 
devreye alınır. 
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e)  Tools Menüsü 

 

 Tools Menüsünden; 

 Lock Device Keyboard seçeneği 

kullanılarak, bağlı bulunulan FCS v4 sisteminin 

tuş takımı kiltlenir / açılır. Böylece sahada 

cihazın parametreleri yetkisi olmayan kişilerce 

değiştirilebilmesinin önüne geçilir. (bu 

seçenek yanlızca USB bağlantı noktası 

üzerinden yapılır.) 

 Back to Normal Operation of FCS 

seçeneği kullanılarak, bağlı bulunulan FCS v4 

sensorlardan okuduğu değere göre çalışmaya 

devam eder. 

 Manuel Start A/Cs seçeneği 

kullanılarak, bağlı bulunulan FCS v4 sistemi 

manuel olarak klima moduna alınır ve klimalar 

çalıştırılır. 

 Manuel Start FANs seçeneği 

kullanılarak, bağlı bulunulan FCS v4 sistemi 

manuel olarak fan moduna alınır ve fanlar 

çalıştırılır. 

 Restart Device seçeneği kullanılarak, 

bağlı bulunulan FCS v4 sistemi yeniden 

başlatılır 

 Clear Device Memory seçeneği 

kullanılarak, bağlı bulunulan FCS v4 sisteminin 

hafızasında bulunan tüm datalar silinir. 

 Restart A/Cs seçeneği kullanılarak, 

bağlı bulunulan FCS v4 sisteminde yer alan 

klima kontrol noktalarınınm15s boyunca 

kontak durumları değiştirilir. Böylece klimalar 

yeniden başlatılır 

 Service seçeneği kullanılarak, bağlı 

bulunulan FCS v4 sisteminin servis ayarlarına 

erişilir. Servis ekranında yapılan ayarlar 

aşağıdaki gibidir. 

1.FCS v4 kontrol siteminin klimaları 

kontrol eden kontakları NC/NO durumlarını 

sistemin çalışma şekline göre optimize 

edilebilir. 

 

2. FCS v4 kontrol siteminin ısıtıcıları 

kontrol eden kontakları klima ya da ısıtıcı 

olarak kullanımına göre optimize edilebilir. 

 

3.FCS v4 kontrol siteminin input 

kontakları NC/NO durumlarını sistemin 

çalışma şekline göre optimize edilebilir. 
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 Communication Configure seçeneği kullanılarak, FCS v4 kontrol ünitesine bağlanılacak, 

erişim noktası ayarları yapılandırılır. 2 farklı bağlantı noktası üzerinden bağlantı gerçeklenir. 

 

 

 1-Ethernet Bağlantısı 

  

 Free Cooling Viewer çalıştırıldıktan sonra “Tools ->Communication Configuration” menüsü 

kullanılır ve şekildeki ekran açılır. “Connection type” kısmında “Ethernet Gateway” seçilir. Şekilde de 

görüldüğü gibi gerekli alanlar FCS cihazıyla haberleşecek biçimde ayarlandıktan sonra “Connection 

Test” butonu ile bağlantı kontrolü gerçekleştirilir. Başarılı bir bağlantı sağlandıktan sonra “Ok” 

butonu ile bu bağlantı noktası ve ayarları kaydedilir. FCS cihazına ayarlar doğru yapıldığı sürece local 

ağda ya da internet üzerinden herhangi bir noktadan erişilebilir. 
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 2-USB/RS485/RS232 Bağlantısı 

  

Free Cooling Viewer çalıştırıldıktan sonra “Tools ->Communication Configuration” menüsü 

kullanılır ve şekildeki ekran açılır. “Connection type” kısmında “Modbus RTU (RS485/RS232/USB)” 

seçilir. Şekilde de görüldüğü gibi gerekli alanlar FCS cihazıyla haberleşecek biçimde ayarlandıktan 

sonra “Connection Test” butonu ile bağlantı kontrolü gerçekleştirilir. Başarılı bir bağlantı sağlandıktan 

sonra “Ok” butonu ile bu bağlantı noktası ve ayarları kaydedilir. USB bağlantı noktası parametreleri 

değişmediği sürece tak-çıkar özelliği mevcuttur. Bu durumda bir sonraki bağlantıda yeniden ayar 

yapmanız gerekmez 
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f) Log in 

  

 log in menüsünden; Yönetici olarak kullanıcı girişi yapabilirsiniz, yönetici yetkisi ile uzaktan 

erişimlerde FCS v4 kontrol ünitesini yeniden başlatma, hafızada mevcut tüm dataları silme ve cihazın 

servis ayarlarını değiştirebilme menüleri kullanılır. 
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Yükleme 
 

 Free Cooling Viewer yazılımını yükleyebileceğiniz kurulum CD 'si kontrol ünitesinin yer aldığı 

paket içerisinde mevcuttur. bu CD kullanılarak aşağıdaki adımları uygulayarak kurulum 

gerçekleştirilebilir. 

 

 Kurulum aşamaları; 

 

 Kurulum CD'si içerisinde yer alan FCS v4 Free Cooling Viewer Setup\setup.exe çalıştırılır.  

Kurulumda ilerlemek için "Next"  buton kullanılınız.   
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Yüklemenin gerçekleşeceği klasör veya yol gösterilir. "Next" butonu ile devam edilir 

 

Yükleme onaylama ekranında kuruluma başlamak için "Next" butonunu kullanarak onaylayıp devam 

ediniz.  
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Yükleme ekranında, yükleme ilerleme miktarını görebilirsiniz. Yükleme tamamlandığında otomatik 

olarak geçilir.  

 

Yüklemenin başarıyla tamamlandığını gösteren Final ekranından "Close" butonu kullanılarak çıkış 

yapılabilir. 
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Kaldırma 
 

 Free cooling viewer uygulamasını kaldırmak için  

çalıştırmanız gerekmektedir. 

 Uygulamanın çalışma dosyaları kaldırılır. Kullanıcının cihazlardan program kullanılarak 

indirilen tüm datalar korunmaktadır. 

 


